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NDS Database Management

The NDS database is managed using the NDS Manager utility 
(ndsmgr32.exe). NDS Manager is a graphical utility that provides partitioning 
and replication services  for NDS on a NetWare server.  NDS Manager also 
has NDS version update capability, the ability  to print a list of partitions in the 
Directory tree, the partition replica list (the replica ring),  and server data, and 
special diagnostic features which allow the administrator to get a sense of the 
general condition of the Directory tree.  NDS Manager is run from a client 
workstation, which reduces  the network administrator’s dependence on using 
RCONSOLE.
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Understanding

This section gives overview information of the NDSTM ManagerTM utility.

Overview of NDS Manager

In NetWare® 4.11, NDS Manager replaces the Partition Manager utility that 
existed under the Tools menu in the NetWare Administrator* utility in earlier 
versions of NetWare 4*.

NDS Manager provides:

� Partitioning and replication services for NDS on a NetWare server

� The ability to repair the NDS database from a client workstation, which 
reduces the network administrator’s dependence on using RCONSOLE

� NDS version update capability so that NetWare 4 servers in a network can 
be updated to a newer version of DS NLM

� The ability to print a list of partitions in the Directory tree, the partition 
replica list (the replica ring), and server data

� Diagnostic features which allow the administrator to get a sense of the 
general condition of the Directory tree

What’s New for NetWare 5

NDS Manager version 1.30 has been updated for NetWare 5.  Some of the 
enhancements include:

� One executable.  The NDS Manager executable, ndsmgr32.exe, works on 
both Windows* 95 and Windows NT*.
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� Transitive synchronization.  This new functionality greatly reduces 
synchronization traffic and allows for larger replica lists.  (See Related 
Topics.)

� Cross platform checking.  Features that cannot be run on non-NetWare 
platforms will not be attempted, rather than try and fail.  These include 
NDS version update and remote repair operations.

� New APIs.  These include APIs for getting and setting NDS statistics, and 
an enhanced ping API for getting platform information.

� Any container object can be made into a partition.  This way, if a third 
party extends the schema with a container object that makes sense to 
partition, it will work.

� Schema Manager updates.  (See Related Topics.)

,03257$17��Before you use NDS Manager version 1.30, make sure you are using 
the NetWare 5* version of the Novell® ClientTM software.

Guidelines for Partitioning and Replicating Your Tree

The following guidelines are only rules of thumb for most networks. However, 
depending on your network’s specific configuration, hardware, and traffic 
throughput, you may need to adjust some guidelines to fit your needs.

Guidelines for Partitioning

Location

� In a network with WAN links, partitions should not span multiple 
locations

� Partition locally around the servers (keep physically distant servers in 
separate partitions)

� Place fewer partitions at the top of the tree with more at the bottom

Size

� Keep partition sizes small

� The root of the current tree partition should remain small

� Typically, a partition should have fewer than 1,500 objects, and no more 
than 3,500
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� Typically, a partition should have fewer than 10-15 subordinate partitions, 
and no more than 40

Example

The following graphic shows a typical tree structure. Note how the Sales 
Organizational Unit is a partition. This could be because the Sales OU is 
across a WAN link, or because it has a large number of User objects in it.

Replication Guidelines

� Replicate locally, not across a WAN link (Replicas across a WAN link 
have to send/receive NDS synchonization information, which can slow 
down network traffic across a WAN link)

� If possible, place master replicas physically close to the master of parent 
and child partitions
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Number

� Always keep 2 or 3 replicas per partition, and no more than 10

� Never store more than 10 replicas on a server

Overview of Working with NDS Manager

Using NDS Manager, you can manage partitions, replicas, servers, repair 
operations, DS.NLM version updates, printing, and preferences.

Working in Views

Most operations can be performed from either the hierarchical Tree View or 
the list of Partitions and Servers. They are represented on the button bar by the 
icons  

 and  

The other view from which you work in NDS Manager is the Partition 
Continuity view, from which you can view the condition of your tree and 
perform repair operations. Before using NDS Manager, you should take a few 
minutes to access these views and become familiar with their features and 
options.

Performing Operations

You can access the options to perform operations from the button bar, menu 
bar, or by right-clicking. A right-click of the mouse on a server, replica, or 
partition will bring up a pop-up menu with most of the available operations for 
that object.
�
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Setting Up

This section gives instructions on how to install NDSTM ManagerTM.

NDS Manager Installation Instructions

NDS Manager (ndsmgr32.exe) is designed to run on both Windows* 95 and 
Windows NT*.  It can be launched as a standalone executable from the 
sys:public directory or from the Tools menu in NetWare® Administrator.

,03257$17��Before you use NDS Manager, make sure you are using the NetWare 5* 
version of the Novell® ClientTM software.

Running NDS Manager Standalone

Create an icon or shortcut that points to ndsmgr32.exe in sys:public/win32.

Running NDS Manager from the Tools Menu in NetWare 
Administrator

Copy the nmsnap32.dll file located in the sys:public/win32 directory to the 
sys:public/win32/snapins directory.  The next time you launch NetWare 
Administrator, you should see NDS Manager as an option under the Tools 
menu.

Access Control

You can control access to NDS Manager by restricting access to ndsmgr32.exe 
and nmsnap32.dll.

If you’re trying to update these files, make sure you don’t have older copies in 
a Win95 or WinNT directory.
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Managing Partitions

This section gives instructions on managing partitions using NDSTM 
ManagerTM.

Overview of Working with Partitions

NDS Manager allows you to manage partitions in your Directory tree. You can 
manage the placement of partition boundaries in your Directory tree and you 
can view partition data.

There are some general guidelines to follow when performing partition 
operations:

� Make sure your Directory tree is synchronizing correctly before you 
move a partition.

You should check a partition’s synchronization status before performing 
any operations. If you have synchronization errors, fix the 
synchronization errors before proceeding with the operation.

� If possible, always perform partition operations with the latest version of 
DS.NLM.

� After performing a partition operation, you need to wait for processes 
throughout the Directory to complete before you can perform an 
operation with that partition again.

Even though a partition operation may appear completed in NDS 
Manager, NDS requires time to synchronize any changes to a partition 
with the replicas of the partition.

Many partition operations may take considerable time to fully 
synchronize across the network. While you can expect partition 
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operations to complete within a few hours, the amount of time required 
for NDS to synchronize the changes in the Directory depends on:

� The number of objects in the partition

� The number of replicas that must be synchronized

� The location of the replicas (they could be on a server across a WAN, 
for example)

� The visibility of servers involved

� Existing wire traffic

Overview of Creating and Merging Partitions

Overview of Creating a Partition

When you create partitions, you make logical divisions of your NDS* tree. 
These divisions can be replicated and distributed among different NetWare 4* 
servers in your network.

When you create a new partition, you split the parent partition and end up with 
two partitions. The new partition becomes a child partition.

For example, if you select an Organizational Unit and create it as a new 
partition, you split the Organizational Unit and all of its subordinate objects 
from its parent partition.

The Organizational Unit you select becomes the root of a new partition. The 
replicas of the new partition will exist on the same servers as the replicas of 
the parent, and objects in the new partition will belong to the new partition’s 
root object.

A partition consists of at least one container object and its associated 
subordinate objects. The container at the top of the partition is called the ’root’ 
of the partition.
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Creating a partition may take some time, since all of the replicas need to be 
synchronized with the new partition information.

When you create a new partition, NDS Manager informs you that the Create 
Partition command was issued to NDS. If you attempt another partition 
operation while the partition is being created, you will receive a message 
telling you that the partition is busy.

You can look at the replica list for the new partition and know that the 
operation is complete when all replicas in the list are in an On state. You must 
manually refresh the view periodically, or else the states will not appear to 
change.

Overview of Merging a Partition

When you merge a partition with its parent partition, the chosen partition and 
its replicas combine with the parent partition. You do not delete partitions--
you only merge and create partitions to define how the Directory tree is split 
into logical divisions.

There are several reasons you might want to merge a partition with its parent:

� The Directory information in the two partitions is closely related

� You want to delete a subordinate partition but you don’t want to delete the 
objects in it

� You’re going to delete the objects in the partition.

� You want to get rid of all replicas of the partition (merging a partition with 
its parent is the only way to delete the partition’s master replica)

� After moving a container (which must be a partition root with no 
subordinate partitions), you don’t want the container to be a partition 
anymore

� You experience changes in your company organization, so you want to 
redesign your Directory tree by changing the partition structure
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Consider keeping partitions separate if the partitions are large (contain 
hundreds of objects) because large partitions slow down network response 
time.

The root partition in the tree cannot be merged because it is the top partition 
and has no parent partition to merge with.

The partition is merged when the process is completed on the servers. The 
operation could take a while to complete.

:$51,1*��Before merging a partition, check the partition synchronization of both 
partitions and fix any errors before proceeding. By fixing the errors, you can isolate 
problems in the Directory and avoid propagating the errors or creating new ones.

Make sure all servers that have replicas (including subordinate references) of 
the partition you want to merge are up before attempting to merge a partition. 
If a server is down, NDS won’t be able to read the server’s replicas and won’t 
be able to complete the operation.

If you receive errors in the process of merging a partition, resolve the errors as 
they appear. Don’t try to fix the error by continuing to perform operations--
doing so will result in more errors.

Create a Partition

Purpose

When you create partitions, you make logical divisions of your NDS* tree. 
These divisions can be replicated and distributed among different NetWare* 
servers in your network.

When you create a new partition, you split the parent partition and end up with 
two partitions. The new partition becomes a child partition. For 
recommendations, see  “Guidelines for Partitioning and Replicating Your 
Tree” on page 12.

You can create a partition only from the Tree View.

Create a Partition

� Click Tree View.

� From the browser, select the container you want to create as a partition.

� Click Create Partition.

� Confirm your request.
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Merge a Partition (with its Parent)

When you merge a partition, the partition and its replicas combine with the 
parent partition, leaving only the parent partition.

You can merge a partition from either the Tree View or the list of Partitions 
and Servers.

� Select the partition you want to merge with its parent partition.

� Click Merge Partition  .

� Confirm your request.

Overview of Moving a Partition and Aborting a Partition 
Operation

Overview of Moving a Partition

Moving a partition lets you move a subtree in your Directory tree. You can 
move a partition root object (which is a container object) only if it has no 
subordinate partitions.

127(��When you move a partition, you must follow NDS* containment rules. For 
example, you cannot move an Organizational Unit directly under the root of the current 
tree, because the root’s containment rules allow Locality, Country, or Organization 
objects, not Organizational Unit objects.

When you move a partition, NDS changes all references to the partition root 
object. Although the object’s common name remains unchanged, the complete 
name of the container (and of all its subordinates) changes.
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When you move a partition, you should select the option to create an Alias 
object in place of the container you’re moving. Doing so allows users to 
continue to log in to the network and find objects in their original Directory 
location.

The Alias object that is created will have the same common name as the 
moved container and will reference the new complete name of the moved 
container.

:$51,1*��If you move a partition and do not create an Alias object in place of the 
moved partition, users who are unaware of the partition’s new location will not easily find 
that partition’s objects in the Directory tree, since they will look for them in their original 
Directory location.

This might also cause client workstations to fail at login if the workstation 
NAME CONTEXT parameter is set to the original location of the container in 
the Directory tree.

Because the context of an object changes when you move it, users whose name 
context references the moved object need to update their NAME CONTEXT 
parameter so that it references the object’s new name.

(To automatically update users’ NAME CONTEXT after moving a container 
object, use the NCUPDATE utility.)

After moving the partition, if you don’t want the partition to remain a partition, 
merge it with its parent partition.

Make sure your Directory tree is synchronizing correctly before you move a 
partition. If you have any errors in synchronization in either the partition you 
want to move or the destination partition, do not perform a move partition 
operation. First fix the synchronization errors.

Overview of Aborting a Partition Operation

You can abort a Create or Merge Partition operation if the operation has not 
yet progressed past the stage at which the change is committed. 

Use this feature to back out of an operation, or if your NDS network returns 
NDS errors or fails to synchronize following a partition operation.

127(��If replicas in your Directory tree experience synchronization errors, an abort 
operation may not always solve the problem. However, you can use this feature as an 
initial troubleshooting option.

If a partition operation cannot be completed because a server is down (or 
otherwise unavailable), either make the server visible to the network so the 
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operation can complete, or attempt to abort the operation. If NDS cannot 
synchronize because the database is corrupted, you should abort any partition 
operation in progress.

Many partition operations may take considerable time to fully synchronize 
across the network, depending on the number of replicas involved, the 
visibility of servers involved, and the existing wire traffic.

If you get an error that says a partition is busy, it doesn’t mean that you should 
abort the operation. You can usually expect partition operations to complete 
within 24 hours. If a particular operation fails to complete within this time 
frame, you should then attempt to abort the operation in progress.

+,17��If you are attempting to abort a merge partition operation, select the partition (the 
child partition) that is merging with its parent. If you are attempting to abort a create 
partition operation, select the parent partition.

Move a Partition (a Container)

Moving a partition lets you move a subtree in your Directory tree. You can 
move a partition root object (which is a container object) only if it has no 
subordinate partitions.

You can move a partition from either the Tree View or the list of Partitions and 
Servers.

� Select the partition you want to move.

� Click Move Partition.

� (Optional) To move the partition to a context besides the root of the 
current tree, either type a new context in To Context or click the browse 
icon  and select the destination partition from the browser.

� (Optional) Check Create an Alias for This Container Object.

You should understand  why to create an alias when moving a container 
object.

� Click Yes.

� Confirm your request.
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Abort a Partition Operation

Use this feature to back out of an operation or if your NDS* network returns 
NDS errors or fails to synchronize following a partition operation.

You can abort a partition operation from either the Tree View or the list of 
Partitions and Servers.

For more information, see  “Overview of Moving a Partition and Aborting a 
Partition Operation” on page 21.

� Select the partition where an operation has begun.

If you are attempting to abort a merge partition operation, select the 
partition (the child partition) that is merging with its parent. If you are 
attempting to abort a create partition operation, select the parent partition.

� Right-click the partition.

� Select Abort Operation.

� Confirm your request.

Overview of Viewing Partition Data

This topic contains the following:

“Overview of Checking the Synchronization Status of a Partition” on page 24

“Overview of Checking Partition Continuity” on page 25

“Overview of Viewing the Partitions on a Server” on page 26

“Overview of Viewing a Partition's Replicas” on page 27

“Overview of Viewing Information about a Partition” on page 27

“Overview of Viewing Partition Hierarchy” on page 27

“Overview of Viewing a List of All Partitions in the Tree” on page 28

Overview of Checking the Synchronization Status of a Partition

Perform this operation as a low-level diagnostic check since it is safe to 
perform under all circumstances. NDS Manager reads the partition status 
attribute for each partition to determine any synchronization errors.
�
 NDS Database Management

NDS Database Management
104-001271-001

December 20, 1999



doc_tpl.fm Rev 99a 28 October 99
This operation allows you to check the synchronization status of partitions in 
your tree. If you run this operation from the Tree View, you can check the 
status of the chosen partition only. If you run this operation from the list of 
Partitions and Servers, you can check the status of all the partitions in your 
Directory tree.

NDS Manager displays the findings of the synchronization check in a dialog 
box. You can then check the partition continuity of any partitions that have 
returned errors and run repair operations on those partitions.

This operation may provide incomplete information since it only checks for 
synchronization errors on the first server in the replica list that responds to the 
request. (Synchronization errors may be occurring on other servers in the 
replica list.)

To check for synchronization errors among all servers that hold a replica of the 
chosen partition, go to the Partition Continuity view.

Overview of Checking Partition Continuity

To check partition continuity (’walk the replica ring’ of a partition) is to 
examine all of the servers holding replicas of a selected partition and to verify 
that each server has the same information for the partition’s replica list (or 
replica ring).

If each server holding a replica of the chosen partition does not have an 
identical replica list, or if a replica cannot synchronize with the Directory tree 
for any reason, then the Partition Continuity view displays one or more errors.
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Errors appear as exclamation points inside the replica icons and look like the 
following:

      

To get context-sensitive help on an error, double-click the icon and from the 
Replica Information dialog box, click Help next to Current Sync Error.

127(��You may also see icons representing unreadable replicas. Unable to read icons 
do not necessarily signify that the servers can’t talk, but at the very least, there is some 
reason the client cannot contact the server for information.

Overview of Viewing the Partitions on a Server

You can select a NetWare Server object and view which partitions have 
replicas stored on it and the type of each partition’s replica. Each partition is 
specified by the complete name of the container object at the root of the 
partition.

You can see how many partitions are stored on the server.

You might want to view the partitions stored on a server if you are planning to 
remove a NetWare Server object from the Directory tree. In this case, you 
could view the replicas you need to remove before removing the object.
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Overview of Viewing a Partition’s Replicas

You can select a partition and view its replica list. This operation lets you 
identify:

� Which servers the partition’s replicas reside on

� Which server holds the master replica of the partition

� Which servers have read/write, read-only, and subordinate reference 
replicas of the partition

Overview of Viewing Information about a Partition

You can view the following details about a partition:

� Its complete name

� The server which holds the master replica. This is a complete name.

� The number of read/write, read-only, master, and subordinate reference 
replicas of the partition

� The time of its last successful synchronization

� The time of its last attempted synchronization

You can gather most of the information about a partition without leaving the 
main view you’re working from. When you select a partition in the browser, 
the replica pane on the right of the browser displays replica information for the 
partition.

The most significant reason to view information about a partition is to identify 
its synchronization information. For example, if the time of a partition’s last 
successful synchronization is earlier than the time of its last attempted 
synchronization, you know that the partition may have synchronization errors. 
(This information about synchronization time is not available on NDS 
versions prior to 489).

Overview of Viewing Partition Hierarchy

You can view the hierarchy of partitions in your Directory tree from the Tree 
View. This view allows you to browse the logical structure of the partitions in 
your Directory tree by expanding and collapsing container objects. In other 
words, you can see which partitions are parent and which are child partitions.
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Overview of Viewing a List of All Partitions in the Tree

You can view a flat list of partitions in your Directory tree from the list of 
Partitions and Servers.

If you want to simply list the partitions in your tree (from a certain context), 
use this view. If you need to see which partitions are parent and child partitions 
(the partition hierarchy), you must go to the Tree View.

Check Synchronization Status of a Partition

NDS Manager reads the partition status attribute for the partition to determine 
any synchronization errors. This is a low-level diagnostic check that is safe to 
perform under all circumstances.

You can check the synchronization status of a partition from either the Tree 
View or the list of Partitions and Servers.

� Select the partition you want to check.

� Click Check Synchronization.

� (Optional) If you attempted this operation from the list of Partitions and 
Servers, you can select to view the synchronization status of all the 
partitions in your Directory tree.

� Click OK.

� Confirm your request.

Check Partition Continuity

This operation helps you identify whether any of a partition’s replicas are 
experiencing synchronization errors. This operation is also known as ’walking 
the replica ring.’

You can check partition continuity from either the Tree View or the list of 
Partitions and Servers.

� Select the partition whose synchronization status you want to view.

� Click Partition Continuity.

In the Partition Continuity view, a replica icon with an exclamation point 
indicates a replica with synchronization errors. To get context-sensitive help 
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on an error, double-click the replica icon and click the question mark beside 
the Current Sync Error field

View the Partitions on a Server

You can view which partitions are allocated to a server by selecting a 
NetWare* Server object and viewing its replica list. This is a routine operation 
that is safe under all circumstances.

You can view the partitions on a server from either the Tree View or the list of 
Partitions and Servers.

View the Partitions on a Server

� Select a NetWare Server object.

If you are in the Tree View, you might have to browse down the Directory 
tree until you find the NetWare Server object whose partitions you want 
to view.

Once you have highlighted the NetWare Server object, the partitions 
stored on the chosen server, as well as the partition’s replica type, are 
shown in the replica pane on the right of the browser.

View a Partition’s Replicas

You can select a partition and view its replica list. This operation lets you 
identify

� Which servers the partition’s replicas reside on

� Which server hosts the master replica of the partition

� Which servers have read/write, read-only, and subordinate reference 
replicas of the partition

� The state of each of the partition’s replicas

You can view a partition’s replicas from either the Tree View or the list of 
Partitions and Servers . View a Partition’s Replicas

� Select a partition.

The servers which contain replicas of the chosen partition are shown in 
the replica pane on the right of the browser.
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View Information about a Partition

This is a safe operation that you can perform under all circumstances.

The most significant reason to view information about a partition is to view its 
synchronization information. (You can gather most of the information about a 
partition without leaving the main view you’re working from.)

You can view information about a partition from the Tree View, the list of 
Partitions and Servers, or the Partition Continuity view.

View Information about a Partition from the Tree View or the List of 
Partitions and Servers

� Select the partition you want information about.

� Right-click and click Information.

View Information about a Partition from Partition Continuity

� Click Repair > Information > Partition.

View Information about an Alias

You can view the origin of an Alias.

� Double-click an Alias object to view the aliased object.

View Partition Hierarchy

You can easily view the partition hierarchy in your Directory tree from the 
Tree View. In the browser on the left side of the Tree View, you can expand 
container objects to view which partitions are parent and which are child 
partitions.

� Expand a partition root object by double-clicking the object.

You can collapse the subtree by double-clicking the object again.
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View List of Partitions in the Tree

This operation allows you to view a list of all the partitions in your Directory 
tree in and below your current context.

If your Directory tree is large (hundreds of partitions) and you perform this 
operation from the root of your tree, you might have to wait several minutes 
while the list builds.

To avoid waiting long periods of time, perform this operation from a given 
context.

� Click Tree View.

� Navigate to and highlight the root of the current tree.

� Click Partitions and Servers.

The list of partitions in the current context is built under the Partitions 
heading (in alphabetical order).

View the Partitions in a Given Context

� Click Tree View  .

� Navigate and highlight the container that you want to set as the new 
context.

� Right-click and click Set Context.

� Click Partitions and Servers. 

Overview of Transitive Synchronization

Transitive synchronization greatly reduces synchronization traffic and allows 
for larger replica lists.

With transitive synchronization, a server doesn’t have to synchronize with all 
other servers in the replica list.  Instead, the server checks a list on the target 
server for when other servers in the replica list synchronized with each other.  
If the target server has synchronized with other servers in the list more recently 
than the source server has, it is not necessary for the source server to 
synchronize with the other servers in the list.

Transitive synchronization also allows for synchronization to occur in a mixed 
protocol environment.  With mixed protocols, it’s not always possible for all 
servers to communicate with each other; however, if a NetWare 5 server in 
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your tree is set up to run multiple protocols, transitive synchronization is 
enabled.

Transitive Synchronization View

The Transitive Synchronization view uses the purge vector to evaluate 
whether synchronization has taken place within the NDS inactivity 
synchronization interval stored on each individual server.  (See Related 
Topics.)

The view displays the replica list (columns) of each server (rows) that holds a 
replica of the chosen partition.

To understand the transitive synchronization grid, read it horizontally, one 
server at a time.  Each row represents the replica list of that server.

Accessing the Transitive Synchronization View

� Select the partition whose synchronization status you want to view.

� Click Partition Continuity.

� Click Transitive Synchronization.
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Managing Replicas

This section gives instructions on managing replicas using NDSTM ManagerTM.

Overview of Working with Replicas

NDS Manager allows you to manage partition replicas. You can manage both 
the number and type of replicas on a server. You can also view information 
about replicas so you can monitor their synchronization status or troubleshoot 
any errors.

Overview of Adding, Deleting and Changing Replica 
Type

This topic contains the following:

� “Overview of Adding a Replica” on page 33

� “Overview of Deleting a Replica” on page 35

� “Overview of Changing Replica Type” on page 36

Overview of Adding a Replica

Creating multiple NDS partitions does not, by itself, increase fault tolerance 
or improve performance of the Directory. However, strategically using 
multiple replicas does.

Novell recommends at least three real replicas for each partition if the 
Directory tree has enough servers to support that number. 'Real' replicas 
means master, read/write, or read-only replicas (subordinate reference replicas 
are created and managed by NDS, not the administrator).
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NDS replication provides:

� Fault tolerance

If a disk crashes or a server goes down, replicas on servers in other 
locations can still authenticate users to the network and provide 
information on objects in partitions stored on the disabled server.

With the same information distributed on several servers, you are not 
dependent on any single server to authenticate you to the network or to 
provide services (such as login).

A single server can store replicas of multiple partitions.

127(��Directory replication does not provide fault tolerance for the file system. 
Only information about Directory objects is replicated.

To provide fault tolerance for your files, you must mirror or duplex your 
hard disks and enable the Transaction Tracking System* (TTS*) feature. 
TTS is enabled by default when the server is installed.

� Faster access across a WAN link

If users currently use a WAN link to access particular Directory 
information, you can decrease access time and WAN traffic by placing a 
replica containing the needed information on a server that users can 
access locally. 

However, in some cases, WAN traffic could increase due to the amount 
of synchronization required.

� Faster access to Directory information

Distributing replicas among servers on the network allows quick and 
reliable access because information is usually retrieved from the nearest 
available server containing the specified information.

� Bindery services

Add a replica of a partition to a server (and set bindery context 
appropriately) to allow users to access bindery services provided by NDS 
objects stored in that partition.

Users will be able to access NDS objects providing bindery services only 
if real objects exist on that server. Adding a replica of a partition to the 
server adds real objects to the server and lets users with User objects in 
that partition log in to the server with a bindery connection.

If a partition is not stored on a server, the Set Bindery Context command 
will fail for contexts in the partition.
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You can add additional replicas of a partition, within these guidelines:

� You can have only one master replica. Additional replicas must be read/
write or read-only.

� You can store only one replica per partition on a server. A single server 
can store replicas of multiple partitions.

Most replicas should be read/write. Read/write replicas can be written to. 
They can handle object viewing, object management, and user login, just as 
the master replica can. They send out information for synchronization when a 
change has been made.

Read-only replicas cannot be written to. They allow object searching and 
viewing, and they are updated when the replicas of the partition synchronize.

Overview of Deleting a Replica

Deleting a replica removes the replica of the partition from a server.

If you want to remove a server from the Directory tree, you could delete 
replicas from the server before removing it. Removing the replicas reduces the 
chance of having problems removing the server.

You can also reduce synchronization traffic on the network by removing 
replicas. Keep in mind that you probably don’t want more than six replicas of 
any partition.

127(��You cannot delete a master replica or a subordinate reference replica.

If the replica you want to delete is a master, you have two options:

� Go to a server with another replica of the partition and make it the new 
master replica.

This automatically changes the master replica to a read/write replica, 
which you can then delete.

� Merge the partition with its parent partition.

This merges the replicas of the partition with those of its parent and 
removes them from the servers they reside on. Merging removes partition 
boundaries, but not the objects. The objects continue to exist on each 
server which held a replica of the ’joined’ partition.
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When you delete replicas, keep the following guidelines in mind:

� For fault tolerance, you should maintain at least three replicas of each 
partition on different servers.

� Deleting a replica deletes a copy of part of the Directory database on the 
targeted server.

The database can still be accessed on other servers in the network, and the 
server that the replica was on still functions in NDS.

You cannot delete or manage subordinate reference replicas. They are created 
automatically on a server by NDS when the server contains a replica of a 
partition but not of that partition’s child.

Overview of Changing Replica Type

You can change the type of a read/write or a read-only replica. However, you 
cannot use a change replica type operation to change the master replica to a 
different type. 

You cannot change the type of a master replica, but a read/write or read-only 
can be changed to a master---and the master will be changed automatically to 
a read/write replica.

Most replicas should be read/write. Read/write replicas can be written to by 
client operations. They send out information for synchronization when a 
change has been made. Read-only replicas cannot be written to by client 
operations. However, they are updated when the replicas synchronize.

You cannot change the replica type of a subordinate reference. To place a 
replica of a partition on a server which currently has a subordinate reference 
requires an Add Replica operation. 

A subordinate reference replica is not a complete copy of a partition. The 
placement and management of subordinate reference replicas is handled by 
NDS. They are created automatically on a server by NDS when the server 
contains a replica of a partition but not of that partition’s child.
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Add a Replica

Creating multiple NDS partitions does not, by itself, increase fault tolerance 
or improve performance of the Directory. However, strategically using 
multiple replicas does.

Add a replica of a partition to a server to provide your Directory tree with

� Fault tolerance

� Faster access to NDS data

� Faster access across a WAN link

� Access to NDS objects in a set context (using bindery services)

You can add a replica of a partition to a server from either the Tree View or 
the list of Partitions and Servers.

Add a Replica

� Select the partition that you want to replicate on a server.

� Click Add Replica.

� Click the browse button to select the server to place the replica on.

� Select the NetWare Server object from the browser and click OK.

� Select either Read/Write or Read-Only.

� Click OK.

� Confirm your request.

Delete a Replica

Deleting a replica removes the replica of a partition from a server.

You can delete a replica from either the Tree View or the list of Partitions and 
Servers.

Delete a Replica

� Select the partition that has a replica you want to delete.

� From the replica pane on the right, select the replica you want to delete.
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� Right-click and click Delete.

� Confirm your request.

Change Replica Type

Change a replica type to control access to the replica information. For 
example, you might want to change an existing read/write replica to a read-
only replica to prevent users from writing to the replica and modifying 
Directory data.

127(��You can’t use this procedure to change the type of the master replica. To specify 
a new master replica, change the type of an existing read/write or read-only replica to 
master, and the original master replica is automatically changed to read/write.

You can change a replica type from either the Tree View or the list of Partitions 
and Servers.

Change a Replica Type

� Select a partition or a server.

� From the replica pane, select the replica you want to change.

� Click Change replica type.

� Select a new type and click OK.

� Confirm your request.

Overview of Viewing Replica Data

This topic contains the following:

� “Overview of Viewing the Replica List of a Partition” on page 38

� “Overview of Viewing Replica Information” on page 39

Overview of Viewing the Replica List of a Partition

From either the  Tree View or the list of Partitions and Servers, you can select 
a partition and view:

� The replicas of that partition

� The type of each replica
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� The state of each replica

� The server each replica is stored on

However, from either of these two views, you will not get a complete list of 
each server’s view. The replica list shown is the view of the first server to 
respond to the request. The Replica Read field in the information bar tells 
which server was read.

Other servers holding a replica of the chosen partition may have different 
views of where the partition’s replicas are stored.

To get a complete view of a partition’s replica list, use the Partition Continuity 
view. This view displays all of the servers that hold a replica of the chosen 
partition, as well as each server’s view of where replicas of the chosen partition 
are stored.

Overview of Viewing Replica Information

This is a safe operation that you can perform under all circumstances.

The most significant reason to view information about a replica is to view its 
synchronization information. (You can gather most of the information about a 
replica without leaving the main view you’re working from.)

This operation allows you to view the following details about a replica:

� Which partition the replica is a copy of

� The server it is stored on

� Its replica number

� Its type

� Its state

� The last time it was successfully synchronized

� Its referral address

� Its current synchronization errors

You can also get additional help on the specific synchronization error by 
pushing the blue question mark button at the end of the error number line.
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View Replica List of a Partition

You can view the replica list of a partition from any view in NDS Manager.

View the Replica List of a Partition

� From either the Tree View or the list of Partitions and Servers, select a 
partition.

The servers which contain replicas of the chosen partition are shown in 
the replica pane to the right of the browser.

To examine all of the servers holding replicas of a chosen partition and to 
verify that each server has a similar view of the partition’s replica list (or 
replica ring), you must  Check Partition Continuity (’walk the replica ring’ 
of a partition).

View Information about a Replica

This is a safe operation that you can perform under all circumstances.

The most significant reason to view information about a replica is to view its 
synchronization information. (You can gather most of the information about a 
replica without leaving the main view you’re working from.)

View Information about a Replica

� From either the Tree View or the list of Partitions and Servers, select a 
partition or a NetWare Server object.

� Right-click on a replica and click Information.

To view replica information from the Partition Continuity view, right-
click a replica in the grid and click Information.
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Managing Servers

This section gives instructions on managing servers using NDSTM ManagerTM.

Overview of Working with Servers

You can

� View information about a server

� Delete a server

� View and update the version of NDS on a server

Since replicas of partitions are stored on servers, anytime you perform an 
operation that affects a partition or a replica, you are affecting the information 
that is stored on a server.

Overview of Viewing Server Information and Deleting a 
Server

This topic contains the following:

� “View Information about a Server” on page 41

� “View a List of All Servers in Your Directory Tree” on page 44

� “Overview of Deleting a NetWare Server Object Warning” on page 42

View Information about a Server

You can gather most of the information about a server without leaving the 
main view you're working from. When you select a server, its replica 
information is displayed in the replica pane on the right.
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The most significant reason to view information about a server is to view its 
synchronization information.

You can view information about a server from the Tree View, the list of 
Partitions and Servers, or the Partition Continuity view.

View a List of Servers in the Directory

From the list of Partitions and Servers, you can view a list of the servers in and 
below your current context in the Directory tree. In other words, if you set 
your context to the root of your tree, you can view every server that exists in 
your tree without having to search the Directory tree by expanding containers 
in the Tree View.

This list takes longer to build than the Tree View.

Overview of Deleting a NetWare Server Object Warning

Deleting a NetWare® Server object  permanently removes the object from 
your NDS tree (the server still has SAP capabilities unless it is permanently 
down).

It also permanently removes the server’s data and resources from the network.

Deleting a NetWare Server object may corrupt your NDS database, especially 
if the NetWare Server object provides NDS database services (such as storing 
replicas).

Use NDS Manager to remove the replicas on the NetWare server and avoid 
deleting a NetWare server that stores the only replica of a partition of the 
Directory tree.

You want to delete a server when:

� The server’s hard drive goes bad and you want to reinstall the server.

� You no longer need that resource in the tree due to company downsizing.

There are several ways to delete a NetWare Server object:

One option (although we don’t recommend this) is to bring a NetWare server 
down and delete its object.  Then reinstall NDS on the server using 
INSTALL.NLM at the server, or recreate the object after bringing the server 
back up.  You will have to use NetWare Administrator to delete Volume 
objects associated with the deleted NetWare Server object.
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Do not delete a server if you just want to move it to a new context. Use the 
NetWare Administrator to move the NetWare Server object and its associated 
Volume objects to another context.

If the server is functioning properly, do the following  before deleting it:

� Change the master replicas stored on this server to read/write replicas and 
then delete all replicas on the NetWare server.

� Remove NDS from the server with the INSTALL.NLM. This procedure 
protects your NDS database from losing services. (This procedure will 
also delete the NetWare Server object for you.)

View Information about a Server

You can gather most of the information about a server without leaving the 
main view you’re working from. When you select a server, its replica 
information is displayed in the replica pane to the right. 

The most significant reason to view information about a server is to view its 
synchronization information.

You can view information about a server from the Tree View, the list of 
Partitions and Servers, or the Partition Continuity view 

View Information about a Server from the Tree View or the List of 
Partitions and Servers

� Select the NetWare Server object you want information about.

127(��The list of Partitions and Servers is the easiest place to access server 
information. If you go to the Tree View, you will have to browse the tree by 
expanding partition root objects until you find the NetWare Server object you want 
information about.

� Click Information.

View Information about a Server from the Partition Continuity View

� Right-click a server name (in the far left column) and click Information.
Managing Servers 
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View a List of Servers in the Directory

This operation allows you to view a list of the servers in your Directory tree 
in and below your current context.

If your Directory tree is large (hundreds of partitions and servers) and you 
perform this operation from the root of your tree, you might have to wait 
several minutes while NDS* Manager* builds a list of all the servers in your 
Directory tree.

To avoid waiting long periods of time, perform this operation from a given 
context. To do so, follow the second procedure below.

This list takes longer to build than the hierarchical Tree View, so in large trees, 
you need to be patient.

View a List of All Servers in Your Directory Tree

� Click Tree View.

� Navigate to and highlight the root of the current tree.

� Click Partitions and Servers.

The list of servers in the current context is built under the Servers heading 
in alphabetical order.

View the Servers in a Given Context

� Click Tree View.

� Navigate and highlight the container that you want to set as the new 
context.

� Right-click and click Set Context.

� lick Partitions and Servers. 

The list of servers in the current context is built under the Servers heading 
in alphabetical order.
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Delete a NetWare Server Object

Deleting a NetWare Server object  permanently  removes the object from your 
network. It also permanently removes the server’s data and resources from the 
network.

Deleting a NetWare Server object may corrupt your NDS database, especially 
if the NetWare Server object provides NDS database services (such as storing 
replicas).

Use NDS Manager to remove the replicas from the server and avoid deleting 
a server that stores the only replica of a partition of the Directory tree.

You can delete a server from either the Tree View or the list of Partitions and 
Servers.

Delete a NetWare Server Object

� Select the NetWare Server object you want to delete.

127(��If you are in the Tree View, you must browse the tree by expanding 
containers until you locate the NetWare Server object in the correct context. If you 
know the context where the server resides, you can set the context from the View 
menu.

� Right-click and click Delete.

Overview of Viewing and Updating Version of NDS

This topic contains the following:

� “Overview of Viewing the NDS Version on Servers in a Container” on 
page 45

� “Overview of Updating Version of NDS on a Server” on page 46

Overview of Viewing the NDS Version on Servers in a Container

View the version of NDS that is running on the servers in your Directory tree 
to see if they are running the most current versions of DS.NLM for that 
operating system release.

In other words, if you notice that certain servers in your tree are running NDS 
version 463 (a NetWare 4.1 version of DS.NLM), while others are running 
version 496 (an updated NetWare 4.1 version of DS.NLM) you should update 
the server running 463 using the server running 496 as the source.
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You can identify which version of NDS is the most current for a particular 
version of NetWare by accessing NetWire* (Novell’s electronic forum) or 
Novell’s web site at http://www.novell.com.

Overview of Updating Version of NDS on a Server

You should update the version of NDS on a server whenever you receive an 
updated DS.NLM. Updated versions of the DS.NLM are available on NetWire 
(Novell’s electronic forum).

Each update of NDS fixes problems and increases functionality. When a new 
version of NDS is released, the new features in NDS are not available unless 
all servers in a partition’s replica ring are running the same version of NDS.

127(��Version update does not support updates across operating system releases. In 
other words, this feature  will  not update a NetWare 4.1 server’s version of NDS to a 
NetWare 4.11 version of NDS. This feature  will update NetWare 4.1 servers running an 
older version of NDS (such as 463) to a newer version of NDS for NetWare 4.1 (such 
as 489).

If a new version of the NetWare 4.11 NDS is released on NetWire, you can 
update your NetWare 4.11 servers with the new version.

View Version of NDS on Servers in a Container

View the version of NDS (DS.NLM) on all the servers in a container object to 
determine whether to update the DS.NLM on any servers. If the version of 
NDS on a server is not the most current version in the tree, consider updating 
the server’s DS.NLM with the version from another server.

You can view the version of NDS on servers in a container from either the Tree 
View or the list of Partitions and Servers.

View Version of NDS on Servers in a Container

� Select the container you want to start from.

127(��If you are performing this operation from the list of Partitions and Servers, 
you cannot see the relationships among the partitions in your tree. It might be 
easier to perform this operation from the Tree View.

� Click Object > Version > View.

Any servers prior to NetWare 4 will show up as Unknown (because they 
are bindery servers that do not have NDS).

� NDS Database Management
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To view the version of NDS on a chosen server, highlight the server and 
click the Information button from the button bar.

Update Version of NDS on a Server

Update the version of NDS* on servers in your Directory tree whenever you 
receive an updated DS.NLM.

Each update of NDS fixes problems and increases functionality. When a new 
version of NDS is released, the new features in NDS are not available unless 
all servers in a partition’s replica ring are running the same version of NDS.

127(��After performing a version update, you may notice that after the servers are 
updated correctly, your client workstation may not recognize they were updated for up 
to 30 minutes.

,03257$17��NDS Version Update does not support updates across operating system 
releases. In other words, this feature will not update a NetWare* 4.1 server’s version of 
NDS to a NetWare 4.11 version of NDS. This feature will update NetWare 4.1 servers 
running an older version of NDS (such as 463) to a newer version of NDS for NetWare 
4.1 (such as 489).

If a new version of the NetWare 4.11 NDS is released on NetWire, you can 
update your NetWare 4.11 servers with the new version.

You can update the version of NDS on a server from either the Tree View or 
the list of Partitions and Servers.

Update Version of NDS on a Server

� Select the NetWare Server object that you want to be the source for 
Version Update (the server that will send a copy of its DS.NLM to other 
servers).

� Click Object > NDS Version > Update.

A dialog box will inform you if any servers in and below the current 
context in your Directory tree cannot be updated. They will be grayed in 
the list.

� From the list of servers on the left, select the servers whose version of 
NDS you want updated and click the right arrow to move them under 
Target Servers to be Updated.

� Click OK.
Managing Servers 
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Managing Preferences and Print 
Options

This section gives instructions on managing preferences and print options 
using NDSTM ManagerTM.

Overview of Working with Preferences and Print 
Options

NDS Manager allows you to set preferences for how information is displayed 
each time you run NDS Manager and how NDS Version Update behaves.

You can print hard copies of the information that appears in NDS Manager.

Overview of Setting Preferences and Print Options

NDS Manager allows you to set preferences for how you want information 
displayed. You can also print information from any of the NDS Manager 
views.

Set Preferences

Set preferences to create default settings for

� How NDS Manager displays information

� How it processes NDS version update operations

� Where it stores the log file after performing an NDS version update 
operation
Managing Preferences and Print Options 
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You can set preferences from the Tree View or from the list of Partitions and 
Servers.

Set Preferences

� Click Object > Preferences.

For information and instructions on choosing specific options, click Help.

Print Object Information

You can print the information about a partition, replica, or server.

You can print object information from the Tree View or from the list of 
Partitions and Servers.

� Click Object > Print.

For information and instructions on choosing specific options, click Help.

Print Replica List of a Partition

You can print the replica list (the replica ring) of a partition. The replica list 
shows each server that has a replica of the chosen partition and each server’s 
replica table.

You can print the replica list of a partition from the Partition Continuity view.

� Click File > Print.

For information and instructions on choosing specific options, click Help.
�� NDS Database Management
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Performing Repair Operations

This section gives instructions on performing NDS database repair operations 
using NDSTM ManagerTM.

Overview of Working with Repair Operations

Perform repair operations when you find synchronization errors or other 
problems in your NDS database.

Most repair operations actually run DSREPAIR.NLM on the server. Any 
errors received during a repair operation are saved in a log file and displayed 
once the operation is complete.

127(��Remote repair operations can only be performed on NetWare® servers.  
Remote repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

Overview of Synchronizing the NDS Database

This topic contains the following:

� “Overview of Synchronizing a Partition Immediately” on page 52

� “Overview of Receiving Updates from the Master Replica” on page 52

� “Overview of Sending Updates from a Replica” on page 53

� “Overview of Viewing Synchronization Errors” on page 53
Performing Repair Operations ��
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Overview of Synchronizing a Partition Immediately

Although NDS automatically synchronizes the Directory data of replicas (so 
that each replica is sent the most recently updated data), you can manually 
synchronize the Directory data of replicas if any replicas get out of sync.

When you choose to synchronize immediately, every server that holds a 
replica of the partition you choose will attempt to synchronize its replica 
information with the replica information on the other servers.

You can perform this operation to synchronize changes you recently made to 
Directory data. For example, if you modified system or user login scripts, you 
can synchronize those changes so users can be authenticated to the network 
immediately.

Overview of Receiving Updates from the Master Replica

This operation forces the replica on the chosen server to receive all NDS 
objects from the master replica of the partition. While in process, this 
operation marks the replica on the chosen server as a new replica (the replica 
state can be seen in the replica list of the server from the Tree View or the list 
of Partitions and Servers).

The replica’s current data will be overwritten with the data from the master 
replica.

Although NDS automatically synchronizes the Directory data among replicas 
(so that each replica is sent the most recently updated Directory objects) this 
operation lets you manually synchronize the Directory objects of replicas if 
any non-master replicas get out of sync.

Perform this operation if a replica becomes corrupted or has not received 
updated data for an extended period of time.

From the Partition Continuity view, you can identify which replicas are out of 
sync with the data of the master replica. They will appear in the partition grid 
with an exclamation point (!) on the replica icon. 

You cannot select this option from a master replica. The master replica is 
assumed to be the most current and accurate copy of the partition. If it’s not, 
assign one of the other replicas to be the master using the Change Replica 
Type operation. The current master replica will be changed automatically to 
read/write.

127(��This operation may create a lot of network traffic, so it is best to run this 
operation during a period of light network traffic.
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Overview of Sending Updates from a Replica

When you send updates from a replica, the Directory objects in that replica are 
sent from the server the replica resides on to all the other replicas of the 
partition, including the master replica.

The other replicas of the partition will combine the new objects sent with the 
objects they already have. If the other replicas have data besides the data sent 
to them, they will retain that data.

Although NDS automatically synchronizes the Directory data among replicas 
(so that each replica is sent the most recently updated Directory objects) this 
operation lets you manually synchronize the Directory objects of replicas if 
any replicas get out of sync.

Overview of Viewing Synchronization Errors

In the Partition Continuity view, if the chosen partition has synchronization 
errors, those errors will appear as exclamation points on replica icons.

You can view the details about the synchronization error---possible causes and 
solutions---by double-clicking the replica icon and then choosing Help  from 
Current Sync Error.

Synchronize a Partition Immediately

When you choose to synchronize immediately, every server that holds a 
replica of the partition you choose attempts to synchronize its replica 
information with the replica information on the other servers.

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

� From the Tree View or the list of Partitions and Servers, select the 
partition you want synchronized.

� Click Partition Continuity.

� Click Synchronize Immediately.

� Confirm your request.
Performing Repair Operations �	
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Receive Updates from Master Replica

This operation deletes the Directory data of a replica and replaces it with data 
from the master replica of the partition. Select this option if the replica is 
corrupted or has not received updated data for an extended period of time.

You can receive updates from the master replica from the Tree View, the list 
of Partitions and Servers, or the Partition Continuity view.

� Select the server (the row) whose replica you want to receive updates.

127(��You cannot perform this operation on a master replica. A master replica 
cannot receive updates from itself.

� Click Receive Updates.

� Confirm your request.

Send Updates from a Replica

When you send updates from a replica, the Directory data in that replica is 
broadcast from the server it resides on to all the other replicas of the partition, 
including the master replica. The other replicas combine the new information 
you sent with the data they already have. If the replicas have data besides the 
data sent to them, they will retain that data.

Select this option if replicas are corrupted or have not received updated data 
for an extended period of time.

You can receive updates from the master replica from the Tree View, the list 
of Partitions and Servers, or the Partition Continuity view.

� Select the server (the row) whose replica you want to broadcast 
information.

� Click Send Updates.

� Confirm your request.
�
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View Synchronization Errors

When working in the Partition Continuity view, you may see an error on one 
of the replicas in the grid. An error appears as an exclamation point (!) on a 
replica icon.

You can view context-sensitive help about the error on the replica. The help 
provides possible causes and solutions to the error.

� Double-click the replica with the error.

� From the Replica Information dialog, click Help next to Current Sync 
Error.

Overview of Repairing the NDS Database

This topic contains the following:

� “Overview of Verifying Remote Server IDs” on page 55

� “Overview of Repairing a Replica” on page 56

� “Overview of Repairing Network Addresses” on page 56

� “Overview of Repairing Local Database” on page 56

� “Overview of Assigning a New Master Replica” on page 57

� “Overview of Removing a Server from a Replica List” on page 57

� “Overview of Repairing Volume Objects” on page 58

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

Overview of Verifying Remote Server IDs

In an NDS tree, the ID for an object is unique on each server. The remote 
server ID list contains a list of IDs for this server's object as it is found on other 
servers' databases. If the remote ID is incorrect, this server may return an NDS 
error, indicating that it cannot authenticate to the remote server.

This operation will verify the remote server's name, the remote server's ID in 
this server's database, and the remote ID, which is this server's ID as it is found 
in the remote server's database. If any errors are detected, this operation will 
attempt to repair the server IDs.
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This operation does not lock the NDS database, so you can run this operation 
as an initial troubleshooting option if you identify NDS errors in Partition 
Continuity.

Overview of Repairing a Replica

Repairing a replica consists of checking the replica ring information on each 
server that contains a replica, and validating the remote ID information. This 
operation repairs only the chosen replica.

If you have not performed the Repair Local Database operation within the last 
30 minutes, you should do so before performing this operation.

Overview of Repairing Network Addresses

You can repair network addresses to ensure that the servers in your network 
are broadcasting correct addresses.

This operation checks the network address for every server in the local 
database by searching for the server’s name in the local SAP tables.

If this operation finds an address in SAP, it compares this address to the 
NetWare Server object’s IPX network address property and the address in each 
replica property of every partition root object.

If the address it finds differs from these, this operation updates it. If this 
operation cannot find a SAP name-to-address mapping, then it cannot make a 
repair for that server.

If you are getting DS errors related to communication between servers, you 
can repair network addresses as a troubleshooting option since it will not lock 
the NDS database.

Overview of Repairing Local Database

You can repair your local database records when you find that your NDS 
database is corrupted. This operation resolves inconsistencies in the local 
Directory database so that it can be opened and accessed.

After the repair is completed, a log of the repair operations is displayed. 
Inspect the repair operations in the log to see if additional work is needed to 
complete the repair. 

If objects in a replica are damaged, delete the replica and add it back, or 
receive updates from the master replica to make sure it is synchronized with 
the other replicas in the partition.
�� NDS Database Management
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If you select this option, there will be a short period of time when users will 
have limited access to resources on the server where you are running this 
operation.

Overview of Assigning a New Master Replica
,03257$17��Don’t use this feature to change a replica type. This is a repair feature 
that should only be used when the current master replica is corrupted or lost.

Assign a new master replica if the current master replica is corrupted or if the 
server the current master resides on loses data integrity or experiences 
hardware failure.

You need a master replica to perform operations with a partition. Assigning a 
new master replica allows you to convert an existing replica to the master 
replica, and allows you to perform partitioning operations.

Overview of Removing a Server from a Replica List
:$51,1*��Misuse of this operation can cause irrevocable damage to the NDS tree.

If a server that is no longer in the tree appears in the replica ring, instead of 
using the Remove Server operation, perform a Delete Server operation to 
delete the server’s object.

Over a period of time, the server object will be deleted and the replica ring will 
be updated accordingly. (This period of time ranges from minutes to several 
hours.)

If the NDS tree is sufficiently damaged to prevent a Delete Server operation 
from completing normally, or if a server exists in the replica list which no 
longer has a replica of the partition, you may then have to use this operation.

Remove a server from a replica list when other servers are trying to 
synchronize with a server that has no replicas of the partition.

For example, in the Partition Continuity view---or upon running DSTRACE 
on the server---you might find errors indicating that a server still has record of 
another server in its replica list when the second server no longer contains a 
replica of the partition in question.  Use the Remove Server operation to 
remove the second server from the first servers replica list.

127(��NDS Manager will attempt a safer Delete Replica operation each time a 
Remove Server request is made. If the Delete Replica cannot be done, NDS Manager 
will prompt the user to continue and go forward with the Remove Server operation. If 
NDS Manager is able to do a Delete Replica operation, the dialog will reflect this in the 
Performing Repair Operations ��
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titlebar and no log file will be displayed afterward. If the Remove Server operation is 
done, NDS Manager will display the log file upon completion of the operation.

Overview of Repairing Volume Objects

This operation checks the association of all the mounted volumes with Volume 
objects in the Directory.

If the volume is not associated with a Volume object, this operation looks for 
one in the context of the NetWare Server object. If the volume is found, then 
the Volume object is attached to the volume.

If the volume is not found, then this operation attempts to create one.

Verify Remote Server IDs

This operation verifies

� The remote server’s name

� The remote server’s ID in a server’s database

� The remote ID, which is this server’s ID as it is found in the remote 
server’s database

If any errors are detected, this operation will attempt to repair the server IDs.

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

Verify Remote Server IDs

� From the Partition Continuity view, select the server (the row) you want 
to verify remote server IDs on.

� Click Verify Remote IDs.

� Confirm your request.

The View Log will appear when the operation is complete.
�� NDS Database Management
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Repair a Replica

Repairing a replica consists of checking the replica ring information on each 
server that contains a replica and validating the remote ID. This operation 
repairs only the chosen replica on the server you select.

If you have not performed the Repair Local Database operation within the last 
30 minutes, do so before performing this operation.

127(��Remote repair operations can only be performed on NetWare servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

� From the Partition Continuity view, select the server (the row) whose 
replica you want to repair.

� Click Repair Replica.

� Confirm your request.

The View Log will appear when the operation is complete.

Repair Network Addresses

You can repair network addresses to ensure that the servers in your network 
are broadcasting correct addresses.

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

� From the Partition Continuity view, select the server (the row) whose 
network addresses you want to repair.

� Click Repair Network Addresses.

� Confirm your request.

The View Log will appear when the operation is complete.
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Repair Local Database

You can repair your local database records if your NDS* database is 
corrupted. This operation resolves inconsistencies in the local Directory 
Database so that it can be opened and accessed.

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

� From the Partition Continuity view, select the server (the row) whose 
local database you want to repair.

� Click  Repair Local Database.

� Confirm your request.

The View Log will appear when the operation is complete.

Assign a New Master Replica

This is a repair feature that should only be used under the following 
conditions:

� The current master replica is corrupted

� The server the current master resides on lost data integrity

� The server the current master resides on has had an unrecoverable hard 
disk failure

,03257$17��Don’t use this feature to change a replica type.

You need a master replica to perform operations with a partition. Assigning a 
new master replica allows you to convert an existing replica to the master 
replica, and therefore allows you to perform partitioning operations.

Before assigning a new master replica, you should try to change an existing 
replica to master using the Change Replica Type operation from the Tree View 
or from the list of Partitions and Servers.

127(��Remote repair operations can only be performed on NetWare* servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.
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Assign a New Master Replica

� From either the Tree View or the list of Partitions and Servers, select the 
partition whose master is corrupted or unrecoverable.

� Click Partition Continuity.

� From the Partition Continuity view, select the server (the row) that you 
want the partition’s master replica to reside on.

� Click Assign New Master.

� Confirm your request.

Remove a Server from a Replica List
:$51,1*�� Misuse of this operation can cause irrevocable damage to the NDS tree.

If a server that is no longer in the tree appears in the replica ring, instead of 
using the Remove Server operation, perform a Delete Server operation to 
delete the server’s object.

Over a period of time, the NetWare Server object will be deleted and the 
replica ring will be updated accordingly. (This period of time ranges from 
minutes to several hours.)

If the NDS tree is sufficiently damaged to prevent a Delete Server operation 
from completing normally, or if a server exists in the replica list which no 
longer has a replica of the partition, you may then have to use this operation.

127(��Remote repair operations can only be performed on NetWare servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.

Remove a server from a replica list when other servers are trying to 
synchronize with a server that has no replicas of the partition.

For example, in the Partition Continuity view---or upon running DSTRACE 
on the server---you might find errors indicating that a server still has record of 
another server in its replica list when the second server no longer contains a 
replica of the partition in question.  Use the Remove Server operation to 
remove the second server from the first servers replica list.
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127(��NDS Manager will attempt a safer Delete Replica operation each time a 
Remove Server request is made. If the Delete Replica cannot be done, NDS Manager 
will prompt the user to continue and go forward with the Remove Server operation. If 
NDS Manager is able to do a Delete Replica operation, the dialog will reflect this in the 
titlebar and no log file will be displayed afterward. If the Remove Server operation is 
done, NDS Manager will display the log file upon completion of the operation.

Remove a Server from a Replica List

� From the Partition Continuity view, select the server (the row) that has a 
replica in its list that you want to remove.

� Click Repair > Remove Server.

Use the drop down box in the Replica field if you want to change the 
replica to be removed.

� Confirm your request.

The View Log will appear when the operation is complete.

Repair Volume Objects

This operation checks the association of all the mounted volumes with Volume 
objects in the Directory.

If the volume is not associated with a Volume object, this operation looks for 
one in the context of the NetWare* Server object. If the volume is found, then 
the Volume object is attached to the volume.

If the volume is not found, then this operation attempts to create one.

127(��Remote repair operations can only be performed on NetWare servers.  Remote 
repair operations for servers other than NetWare can be performed by running 
DSREPAIR at the server’s console.
�� NDS Database Management
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Repair Volume Objects

� From the Partition Continuity view, select the server (the row) whose 
Volume objects you want to repair.

� Click Repair Volume Objects.

Check the Validate Trustee IDs option if you want NDS Manager to 
validate trustee assignments on the file system with User object IDs and 
resolve any that are invalid. You might want to do this if you’ve deleted a 
lot of User objects that had trustee assignments on that volume. This 
would remove the trustee assigments on the objects that no longer exist in 
the tree.

� Confirm your request.

The View Log will appear when the operation is complete.
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Novell Trademarks

Access Manager is a registered trademark of Novell, Inc. in the United States 
and other countries.

Advanced NetWare is a trademark of Novell, Inc. 
AlarmPro is a registered trademark of Novell, Inc. in the United States and 

other countries.
AppNotes is a registered service mark of Novell, Inc. in the United States and 

other countries.
AppNotes is a registered service mark of Novell, Inc. in the United States and 

other countries.
AppTester is a registered service mark of Novell, Inc. in the United States and 

other countries.
BrainShare is a registered service mark of Novell, Inc. in the United States and 

other countries.
C-Worthy is a trademark of Novell, Inc.
C3PO is a trademark of Novell, Inc.
CBASIC is a registered trademark of Novell, Inc. in the United States and 

other countries.
Certified NetWare Administrator in Japanese and CNA-J are service marks of 

Novell, Inc.
Certified NetWare Engineer in Japanese and CNE-J are service marks of 

Novell, Inc.
Certified NetWare Instructor in Japanese and CNI-J are service marks of 

Novell, Inc.
Certified Novell Administrator and CNA are service marks of Novell, Inc.
Certified Novell Engineer is a trademark and CNE is a registered service mark 

of Novell, Inc. in the United States and other countries.
Certified Novell Salesperson is a trademark of Novell, Inc.
Client 32 is a trademark of Novell, Inc. 
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ConnectView is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Connectware is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Corsair is a registered trademark of Novell, Inc. in the United States and other 
countries. 

CP/Net is a registered trademark of Novell, Inc. in the United States and other 
countries. 

Custom 3rd-Party Object and C3PO are trademarks of Novell, Inc. 
DeveloperNet is a registered trademark of Novell, Inc. in the United States and 

other countries. 
Documenter’s Workbench is a registered trademark of Novell, Inc. in the 

United States and other countries. 
ElectroText is a trademark of Novell, Inc. 
Enterprise Certified Novell Engineer and ECNE are service marks of Novell, 

Inc. 
Envoy is a registered trademark of Novell, Inc. in the United States and other 

countries. 
EtherPort is a registered trademark of Novell, Inc. in the United States and 

other countries. 
EXOS is a trademark of Novell, Inc. 
Global MHS is a trademark of Novell, Inc. 
Global Network Operations Center and GNOC are service marks of Novell, 

Inc. 
Graphics Environment Manager and GEM are registered trademarks of 

Novell, Inc. in the United States and other countries. 
GroupWise is a registered trademark of Novell, Inc. in the United States and 

other countries. 
GroupWise XTD is a trademark of Novell, Inc. 
Hardware Specific Module is a trademark of Novell, Inc. 
Hot Fix is a trademark of Novell, Inc. 
InForms is a trademark of Novell, Inc. 
Instructional Workbench is a registered trademark of Novell, Inc. in the 

United States and other countries. 
Internetwork Packet Exchange and IPX are trademarks of Novell, Inc. 
IPX/SPX is a trademark of Novell, Inc. 
IPXODI is a trademark of Novell, Inc. 
IPXWAN is a trademark of Novell, Inc. 
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LAN WorkGroup is a trademark of Novell, Inc. 
LAN WorkPlace is a registered trademark of Novell, Inc. in the United States 

and other countries. 
LAN WorkShop is a trademark of Novell, Inc. 
LANalyzer is a registered trademark of Novell, Inc. in the United States and 

other countries. 
LANalyzer Agent is a trademark of Novell, Inc. 
Link Support Layer and LSL are trademarks of Novell, Inc. 
MacIPX is a registered trademark of Novell, Inc. in the United States and 

other countries. 
ManageWise is a registered trademark of Novell, Inc. in the United States and 

other countries. 
Media Support Module and MSM are trademarks of Novell, Inc. 
Mirrored Server Link and MSL are trademarks of Novell, Inc. 
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